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https://www.youtube.com/watch?v=_FOtT2IMREo.  
 
Questions? Please contact the RSA Help Desk at help@librariesofrsa.org or 866-940-
4083. 
 

Contents 
Document Access......................................................................................................... 3 

OCLC Cataloger Requirements ...................................................................................... 3 

Advanced Cataloging Considerations ............................................................................. 4 

OCLC System Status Dashboard ................................................................................... 5 

Download OCLC Connexion Client ................................................................................ 5 

How to Check the OCLC Connexion Client Version Number ............................................ 5 

OCLC Connexion Authorization ..................................................................................... 6 

WorkFlows Cataloging Authorization .............................................................................. 6 

OCLC Connexion Client Training Modules ...................................................................... 7 

Scope of OCLC Connexion Client Support ...................................................................... 7 

When to Use Connexion Client ...................................................................................... 8 

Impact of the Brief Record Process on OCLC Catalogers ................................................. 9 

How to Reopen a Minimized Connexion Client .............................................................. 10 

Understanding Constant Data ..................................................................................... 10 

Create Constant Data ................................................................................................. 11 

Search and View Constant Data ................................................................................... 14 

Edit Constant Data ...................................................................................................... 15 

Set Default Constant Data ........................................................................................... 15 

Delete Constant Data .................................................................................................. 15 

Backup Constant Data ................................................................................................ 16 

https://support.librariesofrsa.org/bibload-procedure/
https://www.youtube.com/watch?v=_FOtT2IMREo
mailto:help@librariesofrsa.org


Resource Sharing Alliance 

Page 2 

Transfer Constant Data ............................................................................................... 16 

Apply Default Constant Data to a Record ...................................................................... 17 

Apply Constant Data from a List to a Record ................................................................. 18 

Remove Constant Data from a Record .......................................................................... 18 

Configure Export Settings ............................................................................................ 19 

Export Records from Client .......................................................................................... 20 

Important Considerations for OCLC Holdings ............................................................... 21 

Import the OCLC Export File into WorkFlows ................................................................. 21 

Run the WorkFlows Load Bibliographic Records Report ................................................. 23 

Delete Records from the Client Save File ...................................................................... 25 

Appendix A: Brief Record Cleanup Using OCLC Connexion Client ................................... 26 

Appendix B: Updating the Path for Viewing/Printing Bibload Reports ............................... 27 

Appendix C: Removing a Stuck Record from the Client Save File..................................... 29 

 
  



Resource Sharing Alliance 

Page 3 

Document Access 
The Bibload Procedure is available only to member library staff who complete the RSA 
Bibload Workshop or have been previously trained on OCLC Connexion Client, either 
internally at their library or by RSA.  
 
This document is searchable on the RSA support site (support.librariesofrsa.org). It is not, 
however, publicly posted on the support site to ensure only those member library staff with 
the appropriate training and the necessary WorkFlows cataloger account configuration 
have access to the document.  
 
This document is available here: https://support.librariesofrsa.org/bibload-procedure/   
 
Before the workshop, the instructor will send a printed copy of the Bibload Procedure to 
each participant through RAILS delivery. The instructor will also share the procedure’s link 
via the Microsoft Teams chat during the workshop, so participants can save a copy to their 
computer. Participants are encouraged to take notes during the workshop to supplement 
this document.  
 
 

OCLC Cataloger Requirements  
An OCLC cataloger must meet all of the OCLC cataloging requirements in the RSA 
Bibliographic Database Standards: 

• Completion of basic WorkFlows cataloging training provided by RSA or by another 
staff member at the library who has previously participated in this training. 

• At least six months of experience cataloging in WorkFlows, which can be 
reconsidered on an individual staff member basis at the discretion of the RSA 
Bibliographic Services Manager in consultation with the library staff member’s 
supervisor. 

• Completion of OCLC Connexion Client training modules and the RSA Bibload 
Workshop. Training may also be provided by another staff member at the library 
who has previously participated in this training. 

• Active subscription to the RSA Cataloging email forum. All staff with WorkFlows 
cataloger accounts are subscribed to the Cataloging forum.  

  

https://support.librariesofrsa.org/bibload-procedure/
https://support.librariesofrsa.org/project/bibliographic-database-standards/
https://support.librariesofrsa.org/project/bibliographic-database-standards/
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Advanced Cataloging Considerations   
There is no requirement or expectation from RSA for the membership to catalog at the 
advanced level, which includes the following tasks:  

• Editing the bibliographic description on existing OCLC records 
• Upgrading existing OCLC records with minimal bibliographic description to full 

description 
• Deriving or creating new original OCLC records 

The RSA Bibliographic Services Department provides advanced cataloging service as part 
of your library’s RSA membership fee. RSA does not provide training for member library 
staff on how to edit, upgrade, derive, or create OCLC records. 
 
If you are interested in cataloging at the advanced level, please consider the following: 

• Before you get started, check with your supervisor, Director, or administration to 
ask their permission and determine if that type of cataloging falls within your 
position’s responsibilities.  

• If you receive permission from your supervisor, Director, or administration to do 
advanced cataloging, please do the following: 

▪ Participate in a cataloging course provided by the Cataloging Maintenance 
Center or RAILS. Check L2 for current offerings. Receive permission from 
your supervisor, Director, or administration prior to registering.  

▪ Catalog on the WorldCat level, not the copy of the record in your Connexion 
Client save file. Validate and replace the WorldCat record to contribute it to 
OCLC. WorldCat level cataloging allows OCLC member libraries to use the 
record as they catalog their copies of that item, avoiding the need for each 
OCLC member to edit, upgrade, or create the record themselves.  

▪ Catalog using full bibliographic description according to guidelines in OCLC 
Bibliographic Formats and Standards, Resource Description and Access, 
and Library of Congress Policy Statements.  

 
 
  

https://librarylearning.org/events
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OCLC System Status Dashboard 
Sign up here to receive email notifications of OCLC service outages (planned or 
unplanned).  
 
View real-time OCLC system status here. 
 
Frequently asked questions about the OCLC System Status Dashboard are available here.  
 
 

Download OCLC Connexion Client  
OCLC Connexion Client 3.1 is the most up-to-date version. Download Client 3.1 here if 
your computer meets the system requirements on this page.  
 
Download Connexion Client 2.63 here if your computer does not meet the system 
requirements for Client 3.1. OCLC will discontinue support for Client 2.63, but no sunset 
date has been determined.  
 
Connexion Client may be installed on an unlimited number of computers at your library at 
no additional cost. 
 
Please contact OCLC Support at support@oclc.org or 1-800-848-5800 for download 
assistance.  
 
 

How to Check the OCLC Connexion Client Version Number 
1. Open OCLC Connexion Client. 
2. Click on the Help menu at the top of the screen. 
3. Select “About OCLC Connexion Client.” 
4. The first line of the popup box indicates the version number. 

 

 
  

https://oclc.service-now.com/status?id=subscription
https://oclc.service-now.com/status
https://help.oclc.org/Librarian_Toolbox/OCLC_System_Status_Dashboard_frequently_asked_questions?sl=en
https://help.oclc.org/Librarian_Toolbox/Software_downloads/Download_cataloging_software?sl=en#Connexion_client_3.1
https://help.oclc.org/Librarian_Toolbox/Software_downloads/Download_cataloging_software?sl=en#System_and_user_requirements
https://help.oclc.org/Librarian_Toolbox/Software_downloads/Download_cataloging_software?sl=en#Connexion_client_2.63
mailto:support@oclc.org
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OCLC Connexion Authorization 
You will need your library’s OCLC Connexion authorization and password to use the Client.  
 
Please contact OCLC Support at support@oclc.org or 1-800-848-5800 if you are unsure of 
your authorization or password. Share your library’s name and OCLC symbol when you 
contact OCLC Support. You can look up your library’s OCLC symbol in the Directory of 
OCLC Members.  
 
 

WorkFlows Cataloging Authorization 
Only you should use your WorkFlows individual cataloger account to catalog. Do not share 
it with other staff to use as they catalog.  
 
If you log into a circulation, reference desk, or another shared computer with your 
cataloger account, any staff may use it to check out items and place holds. This shared 
approach for circulation avoids the negative impact on customer service that comes with 
shutting WorkFlows and reopening it to log in with a non-cataloger account. 
 
Overdue, bill, and courtesy notices (if set up for your library) will continue to run under your 
library’s CIRC account. These notices are unable to run under a cataloger account. 
 
Your cataloger account has a note on it that it should not be used to check out items or 
place holds. The account is barred to prevent checkouts to yourself. Use your “regular” 
patron account for personal checkouts and holds.  
 
Your cataloger account includes the following access:  

• Basic cataloging = add, edit, and delete items in the WorkFlows cataloging module 
• Brief record cataloging = use the Add Title wizard to create brief records for items 

without matching records already in WorkFlows and OCLC 
• OCLC cataloging = import a file of OCLC records into WorkFlows and run a report to 

load them, which makes them searchable in WorkFlows and the RSAcat 
• Circulation = do any task in the circulation module (check out, discharge, place 

holds, mark item used, etc.) 
 

Your cataloger account may also be configured with item group editor access depending 
on the responsibilities of your position and your completion of training.  
 
You will see an “enter override” popup if you try to access a WorkFlows wizard not 
configured into your account. Contact the RSA Help Desk if the correct access levels are 
not configured in your cataloger account, but please first check with your supervisor or 
Director. 
 
 

mailto:support@oclc.org
https://www.oclc.org/en/contacts/libraries.html
https://www.oclc.org/en/contacts/libraries.html
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Cataloger account pin: 
• Changing your pin is optional.  
• To change your pin, follow the instructions in this document.  
• After you change your pin, make a note to remember it. The pin is not visible in the 

WorkFlows Modify User wizard due to pin masking, a feature to strengthen pin 
security. 

• Contact the RSA Help Desk if you forget your pin and want RSA to reset it. 
 
If you stop working in the library, keep RSA informed by contacting the Help Desk. RSA will 
remove your account from WorkFlows and confirm with your supervisor or Director. 
Cataloger accounts are configured to prevent library staff from accidentally removing 
them. 
 
 

OCLC Connexion Client Training Modules 
This document explains how to use the Client to make bibliographic records usable for 
RSA, including how to add library-specific call number/item information to the records and 
load them into WorkFlows so they are visible in the RSAcat.  
 
Before starting to use this document, please complete these modules to learn how to use 
OCLC Connexion Client:  

• Foundations of Connexion client (62 minutes) 
• Bibliographic searching (56 minutes) 
• Save files and batch processing (55 minutes) 

 
 

Scope of OCLC Connexion Client Support 
Scope of RSA support for OCLC Connexion Client: 

• Constant data / 949 templates  
• Exporting  
• Importing  
• WorkFlows bibloads 
• Brief record cleanup 

For questions or assistance with all other Connexion topics, please contact OCLC Support 
at support@oclc.org or 1-800-848-5800. 
  

https://support.librariesofrsa.org/project/workflows-cataloging-set-up-guide/
https://oclctrainings.webex.com/oclctrainings/ldr.php?RCID=d69a5945d6d868bfdefd2e28ba3f5a06
https://oclctrainings.webex.com/oclctrainings/ldr.php?RCID=e625f4fd10456c784669d04efe3e1adb
https://oclctrainings.webex.com/oclctrainings/ldr.php?RCID=c1a27556337ef4d913c7f36c18eedd51
mailto:support@oclc.org
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When to Use Connexion Client 
Please search WorkFlows, not OCLC Connexion Client, first when you need to catalog an 
item. 
 
Searching WorkFlows is a crucial first step for two reasons: 

• Searching WorkFlows first saves you the extra time and effort of using Connexion if 
there is already a matching OCLC record in WorkFlows. 

• By searching WorkFlows first and attaching to the matching record, you prevent the 
occurrence of multiple OCLC records that describe the same item. Multiple 
records that describe the same item cause confusion when staff and patrons place 
holds in WorkFlows or RSAcat, resulting in extended fill times for holds.  

 
If you find a matching OCLC record in WorkFlows, attach your item using the Call Number 
and Item Maintenance wizard.  
 
No need to search Connexion if there is a matching OCLC record for your item already in 
WorkFlows. * 

* Exception: Your library position requires you to upgrade the OCLC record to full 
level bibliographic description in Connexion and re-import the record into 
WorkFlows to update the existing record.  

 
If there is no matching OCLC record in WorkFlows, or there is only a brief record, search 
Connexion.  
 
If there are multiple records in Connexion that describe the same item, choose the one 
with the fullest bibliographic description, which includes (but is not limited to): 

• author 
• title 
• edition statement 
• publication information 
• physical description 
• contents note 
• summary  
• technical specifications for non-print materials  
• subject and genre headings  

 
If a record with less than full bibliographic description is the only or the best one available 
in Connexion (i.e., the record is assigned any encoding level other than I or blank), attach 
your 949 tag to that record and import it into WorkFlows.  
 
Continue to send local history, genealogy, and other special collections items to the 
Cataloging Maintenance Center (CMC) for free OCLC cataloging. Prior to sending an item 
to the CMC: 
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• Review the CMC web site for item eligibility and submission instructions.  
• Contact the CMC at cmc@illinoisheartland.org or 618-467-8649 to confirm your 

item is eligible and verify submission instructions.  
 
The RAILS World Language Cataloging Services Program provides free OCLC cataloging for 
non-English materials that are considered part of a library’s regular collection. Please refer 
to the RAILS World Language Cataloging Services web site for eligibility requirements and 
submission guidelines. Contact Nincy George at nincy.george@railslibraries.org or 
630.734.5128 with any questions about this service.  
 
 

Impact of the Brief Record Process on OCLC Catalogers 
On July 1, 2022, RSA implemented a cataloging process that changed how items without 
matching records in WorkFlows or OCLC Connexion are cataloged. For a step-by-step 
overview of this cataloging process, please go here. 
 
The brief record cataloging process has three goals: 

1. Faster = Speed up cataloging items without matching records, getting the item into 
the patron’s hands quicker than waiting for RSA to provide a record. 

2. Easier = Less work upfront for RSA members than submitting a cataloging request. 
No need to re-catalog your item when the OCLC record is ready and no CHANGE ME 
placeholder call number to edit. 

3. Avoid duplication = Reduce the number of times the same item is submitted as a 
cataloging request by different libraries. 

If there is no matching record in WorkFlows or Connexion, you will create a WorkFlows 
brief record with minimal bibliographic description to allow your item to begin circulating. 
This guide provides step-by-step instructions how to create a brief record, as well as an 
appendix with screenshots of brief records by format (books, audiobooks, DVDs, etc.).  
 
If you find an existing OCLC record that matches your item in WorkFlows, attach your item 
or import the record from Connexion if it is not yet in WorkFlows. No need to create a brief 
record in this case. Only if there is no matching record for your item in WorkFlows or 
Connexion, create a brief record. 

The RSA Bibliographic Services Department will place a copy-level hold on your item when 
they are ready to upgrade its brief record to an OCLC record. This approach will avoid the 
accumulation of a backlog and allow RSA to process items faster, within 14 business days. 
For a step-by-step explanation of what will happen when RSA is ready to upgrade a brief 
item to an OCLC record, please refer to this procedure, as well as the accompanying video 
(about 12 minutes). 

 

https://www.illinoisheartland.org/services/cmc
mailto:cmc@illinoisheartland.org
https://railslibraries.org/catalogs/cataloging-services
mailto:nincy.george@railslibraries.org
https://support.librariesofrsa.org/project/overview-of-the-new-rsa-cataloging-process-for-items-without-matching-records/
https://support.librariesofrsa.org/project/create-a-brief-record/
https://support.librariesofrsa.org/project/procedure-when-rsa-is-ready-to-upgrade-your-brief-item-to-an-oclc-record/
https://youtu.be/rPk66VIJxsM
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How to Reopen a Minimized Connexion Client 
If you open the Client and click the minus sign in the upper right corner to minimize it on 
your screen, you may not be able to reopen it by clicking on its icon from your desktop 
taskbar. This is a known glitch.  
 
To reopen the minimized Client: 

1. Right click the Client icon on the desktop taskbar. 
 

 

 
 

2. Click OCLC Connexion from the menu. 
 

 
 
The Client will maximize, reopening on your screen.  
 
 

Understanding Constant Data 
Use the MARC 949 tag to enter the information you would enter in the Call Number and 
Item Maintenance wizard if you were cataloging in WorkFlows: 

• Call number 
• Item ID 
• Your library’s WorkFlows code 
• Home location  
• Price  
• Item type  
• Item category 1  
• Item category 2  
• Item category 3 
• Item category 4  
• Item category 5 
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Item categories 6-10 are not entered in the 949 tag, but one exception is noted further 
below in the “Create Constant Data” section.  
 
When you load an OCLC record into WorkFlows with a 949 tag, the information from that 
tag will automatically populate the WorkFlows call number/item record if you correctly 
entered it in the 949 tag. Item categories 6-10 will automatically populate with the 
UNDEFINED value. No need to search for the loaded record in WorkFlows to manually 
assign the call number and item information. 
 
To avoid entering the same information into the 949 tag on multiple OCLC records, use 
bibliographic constant data to create 949 templates for each format your library regularly 
catalogs, such as books, books on CD, DVDs, and Blu-rays. 
 
After 949 templates are created for your regularly cataloged formats, there is no need to 
manually enter most of the information into the 949 tag when you apply it to a record. 
However, for each record, make sure:  

• To edit the call number, item ID, and price in the 949 tag because that information is 
unique to each item 

• To check the 949 tag applied to the record to ensure its home location, item type, 
and item categories are applicable to the item being cataloged  

 
If you use OCLC Connexion Client on multiple computers, set up 949 templates in each 
Client or use the backup/transfer instructions later in this document to copy/paste the 949 
templates from one Client into another. The 949 templates are saved in each Client and 
not automatically transferrable to another Client.  
 
 

Create Constant Data 
1. Go to the Cataloging menu. 
2. Select “Create.”  
3. Select “Constant Data.”  
4. On the pop-up box, use the “Workform Type” drop-down menu to select the format 

for which you want to create constant data:  
• books 
• continuing resources (magazines) 
• mixed materials (kits) 
• sound recordings (audiobooks or music) 
• visual materials (DVDs, Blu-rays)  

5. Click OK after you have made your selection from the “Workform Type” drop-down 
menu.  

6. If the constant data work form displays as a small window on the Client screen, do 
the following to expand the work form: 

a. Go to the Window menu.  
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b. Select “Tile Horizontally.” 
7. On the constant data work form, place your cursor after the ǂu in the bottom line.  
8. Hit <Enter> on your keyboard to create a blank line. 
9. In the far-left box of that blank line, type 949.  
10. In the long box in the 949 line, follow the structure below to create a template with 

the call number and item information you would enter in the Call Number and Item 
Maintenance wizard if you were cataloging in WorkFlows.  

 
Structure of the 949 template: 
 
949 _ _   CALLNUMBER |iITEMID |mWORKFLOWSLIBRARYCODE |lHOMELOCATION 
|pPRICE |tITEMTYPE |xITEMCAT1 |zITEMCAT2 |0ITEMCAT3 |1ITEMCAT4 |2ITEMCAT5 
 
Example 949 templates:  
 
For a book: 
949 _ _   FIC EVA |iA12566743299 |mAG_ALS-PDC |lFICTION |p12.00 |tN-BK |xFICTION 
|zADULT |0BOOK |1MYSTERY |2PAPERBACK 
 
For a Blu-ray: 
949 _ _   BLU TRO |iA12566744653 |mAG_ALS-PDC |lAV-MOVIE |p25.00 |tBLU-RAY 
|xFICTION |zJUVENILE |0MOVIE |1ANIMATED |2MOVIE-PG 
 
Tips for creating 949 templates:  
 

• The subfield codes are entered in lowercase (e.g., |m), but the information you enter 
into the subfields (e.g., AG_ALS-PDC) is typed in CAPS. An easy approach is to type 
all the subfield codes in lowercase first, turn on your CAPS LOCK key, and then type 
the uppercase information into the subfields. 

• Enter subfields in the order shown above. The order ensures the call number and 
item information will correctly load into WorkFlows.  

• To create a pipe ( | ) delimiter, simultaneously press the <Shift> key and the key 
above <Enter> with the slash ( \ ) 

• No space between the pipe delimiter and the lowercase subfield code 
Example:  |i   not   | i 

• No space between the lowercase subfield code and the content that immediately 
follows it 

Example:   |lFICTION   not   |l FICTION 
• For the item type ( |t ), only use codes RSA has set up with your library’s preferred 

circulation and/or hold rules. Submit a report request if you are unsure of the item 
types currently used by your library.  

• Price ( |p ) is optional, but RSA recommends entering it to ease item replacement. If 
you choose not to enter a price, delete subfield |p 

https://support.librariesofrsa.org/project/report-request-forms/
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• The use of item category 1 ( |x ), item category 2 ( |z ), and item category 3 ( |0 ) is 
mandatory. 

o Item category 1 = FICTION, NONFICTION, or EQUIPMENT 
o Item category 2 = ADULT, JUVENILE, or YOUNGADULT 
o Item category 3 = Use the code that corresponds to the item type in subfield 

|t. For a complete list of item types and their corresponding item category 3s, 
go here. 

• Assigning an item category 4 for genre is recommended but not required. For a 
complete list of item cat 4s, go here. RSA recommends checking with fellow staff to 
agree on the item cat 4s to use for your collection. If you do not use item cat 4, 
delete subfield |1 from the 949 tag or enter UNDEFINED into it. 

• Assigning an item category 5 for sub-genre is optional. For a complete list of item 
cat 5s, go here. RSA recommends checking with fellow staff to agree on the item cat 
5s to use for your collection. If you do not use item cat 5, delete subfield |2 from the 
949 tag or enter UNDEFINED into it. 

• The OCLCEXCLUD item category 6 may be assigned to an item whose holding 
should not be updated in OCLC WorldCat during the RSA monthly process that 
batch updates OCLC holdings. Because the holding is not updated in OCLC, the 
item will not be visible for WorldShare interlibrary loan requests. 

o To enter OCLCEXCLUD into the 949 tag, use subfield |6 after subfield |2. An 
example 949 tag would look like this: 
 
949 _ _ FIC EVA |iA12566743299 |mAG_ALS-PDC |lFICTION |p12.00 |tN-BK 
|xFICTION |zADULT |0BOOK |1MYSTERY |2PAPERBACK |6OCLCEXCLUD 
 

o Assigning the OCLCEXCLUD item cat 6 is optional. Omit subfield |6 from the 
949 tag if OCLCEXCLUD is not applicable to the item. When the OCLC record 
is loaded into WorkFlows, the item cat 6 will automatically populate with the 
UNDEFINED value if subfield |6 is omitted.  

• RSA does not currently use item categories 7-10, so these codes are not entered in 
the 949 tag. Item categories 7-10 will automatically populate with the UNDEFINED 
value when the OCLC record is loaded into WorkFlows. 
 

11. After you finish entering the 949 template, go to the Action menu. 
12. Select “Save Record to Local File.” 
13. Enter a name in the “Constant Data Name” field that allows you to easily identify 

the type of item it describes. Consider mentioning the reading level, home location, 
and item type in the name.  

Example: Adult Fiction New Book 
14. If this template will be frequently used when you catalog in the Connexion Client, 

check the box next to “Make Default Constant Data.”  
15.  “My Status” leave blank. 
16. Click OK.  

https://alsi.sdp.sirsi.net/client/search/asset/3842
https://alsi.sdp.sirsi.net/client/search/asset/3862/0
https://alsi.sdp.sirsi.net/client/search/asset/3863
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17. On the “Fields to Apply” pop-up, select “Variable.” 
18. Click OK.  
19. If you used the computer file, sound recording, or video recording work form for the 

constant data template, check your template to ensure one of these 245 fields does 
not appear above the 949 tag:  

 

 
 

or 
 

 
 

or 
 

 
 

20. If one of these 245 fields appears on your template, do the following: 
a. Right click anywhere on the 245 line. 
b. From the menu, select “Delete Field.” 

21. Go to the Action menu.  
22. Select “Save Record to Local File.”  
23. Click the black X in the upper right corner to close the template.  

 
 

Search and View Constant Data 
1. Go to the Cataloging menu.  
2. Select “Search.”  
3. Select “Local Constant Data.” 
4. On the pop-up, click OK to return a list of all 949 templates saved in the Client on 

that computer. Those same templates cannot be viewed on a different computer 
with Client.  
 
A list of 949 templates will display on the screen.  

   
To view a template, double click to open it. 
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Edit Constant Data 
1. Search for constant data using the instructions in the previous section. A list of 949 

templates will display on the screen.  
2. Double click on the 949 template in need of edit. 
3. Change the necessary information in the template, such as correcting a typo or 

editing a cataloging code. You cannot rename the template.  
4. After you finish editing the template, go to the Action menu. 
5. Select “Save Record to Local File.” 
6. To return to the list of 949 templates, click the black X in the upper right corner.  

 
 

Set Default Constant Data 
1. Search for constant data using the instructions earlier in this document. A list of 949 

templates will display on the screen. The name of your default template displays at 
the top of the list. 

2. To set a different template as the default, double click on it from the list.  
3. Go to the Edit menu. 
4. Select “Constant Data.” 
5. Select “Local.” 
6. Select “Set as Default.” 
7. On the “Fields to Apply” pop-up, select “Variable.” 
8. Click OK.  
9. Click the black X in the upper right corner to shut the template. 
10. Click the next black X in the upper right corner to shut the list of 949 templates.  
11. Search for constant data again using the instructions earlier in this document. The 

name of the template set as the new default displays at the top of the list.  
 
 

Delete Constant Data 
1. Search for constant data using the instructions earlier in this document. A list of 949 

templates will display on the screen. 
2. From the list, single click on the template to delete. 

3. Click the Delete Records toolbar button:   
4. On the pop-up, click Yes to delete the template. 

 
If the template to delete is set as the default, a pop-up will prevent the deletion. 

1. Click OK to close the pop-up. 
2. Use the instructions earlier in this document to set a different template as your 

default constant data.  
3. Repeat the Delete Constant Data instructions above to delete the unwanted 

template. The template will delete because it is no longer the default.  
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Backup Constant Data 
Save a backup of your 949 templates for two reasons: 

• The 949 templates are saved in each Client and not automatically transferrable to 
another Client.  

• If you receive a new computer or your current one crashes and is rebuilt, you will 
need to create the 949 templates “from scratch” if you did not save a backup.  

 
The next section in this document explains how to transfer the templates from the backup 
to Client on another computer.  
 

1. Search for constant data using the instructions earlier in this document. A list of 949 
templates will display on the screen. 

2. Double click on the first 949 template in the list.  
3. Starting with the call number, drag your cursor to the right until the entire 949 

template is highlighted in blue. 
4. Hover your cursor over the highlighted template, right click, and select “Copy.” 
5. Open a Word or Notepad document on your computer. 
6. In that document, type the name of the template you highlighted in step 3 above. 
7. Hit <Enter> on your keyboard to make a blank line after the template name. 
8. Right click and click “Paste” or the clipboard icon. The entire 949 template, starting 

with the call number through subfield |2 with the item category 5 code, will display 
in the document. 

9. Return to the Client. Click the black X in the upper right corner to return to the list of 
templates.  

10. Repeat steps 2-9 above for the rest of the 949 templates.  
11. After you finish copy/pasting all the templates, save the backup document in a 

location, such as a flash drive or a cloud storage site (e.g., Google Drive or 
Dropbox), which you will be able to easily access if: 

• you receive a new computer  
• your current computer crashes and is rebuilt  
• you need to transfer the templates to another computer with Client  

 
Each time you edit an existing or create a new 949 template in Client, keep your backup 
document updated.  
 
 

Transfer Constant Data  
The 949 templates are saved in each Client and not automatically transferrable to another 
Client. Use your backup document to transfer the templates from one Client to another. 
No need to manually create the 949 templates “from scratch.”  
 

1. Open Client that needs 949 templates set up in it. 
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2. On the same computer as that Client, open your backup document created in the 
previous section.  

3. From the backup document, drag your cursor left to right to highlight the entire 
template, starting with the call number through subfield |2 with the item category 5 
code. 

4. Hover your cursor over the highlighted template, right click, and select “Copy.” 
5. Go to the Cataloging menu in the Client. 
6. Select “Create.”  
7. Select “Constant Data.”  
8. On the pop-up box, use the “Workform Type” drop-down menu to select the format 

for which you want to create constant data:  
• books 
• continuing resources (magazines) 
• mixed materials (kits) 
• sound recordings (audiobooks or music) 
• visual materials (DVDs, Blu-rays)  

9. Click OK after you have made your selection from the “Workform Type” drop-down 
menu.  

10. On the constant data work form, place your cursor after the ǂu in the bottom line.  
11. Hit <Enter> on your keyboard to create a blank line. 
12. In the long box in the 949 line, right click and select “Paste.” The entire 949 template 

you copied from the backup document, starting with the call number through 
subfield |2 with the item category 5 code, will display on the Client screen.  

13. Go to the Action menu in the Client. 
14. Select “Save Record to Local File.” 
15. Enter a name in the “Constant Data Name” field that allows you to easily identify 

the type of item it describes.  
Example: Adult Fiction New Book 

16. If this template will be frequently used when you catalog in the Connexion Client, 
check the box next to “Make Default Constant Data.”  

17.  “My Status” leave blank. 
18. Click OK.  
19. On the “Fields to Apply” pop-up, select “Variable.” 
20. Click OK.  
21. Click the black X in the upper right corner to close the template.  
22. Repeat the steps in this Transfer Constant Data section until you copy/paste all the 

templates from your backup document into the Client.  
 
 

Apply Default Constant Data to a Record  
1. With the matching record for your item in need of cataloging open on your screen, 

go to the Edit menu. 
2. Select “Constant Data.” 
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3. Select “Local.” 
4. Select “Apply Default.” 
5. The 949 template will display toward the bottom of the record. Edit the template to 

the applicable call number and item information for that item. Remember to type 
the information in uppercase. 

6. Go to the Action menu. 
7. Select “Save Record to Local File.” The record will stay in your file until you delete it. 
8. Click the black X in the upper right corner to shut the record. 

 
 

Apply Constant Data from a List to a Record 
Applying constant data from a list is an alternative to applying default constant data. No 
need to do both for the same record. 
 

1. With the matching record for your item in need of cataloging open on your screen, 
go to the Edit menu. 

2. Select “Constant Data.” 
3. Select “Local.” 
4. Select “Apply from List.”  
5. On the pop-up, click OK to return a list of all 949 templates saved in the Client on 

that particular computer.  
6. A list of 949 templates will display on the screen. Single click the template to use for 

your item. 
7. Under “Choose Fields to Apply,” select “Variable.” 
8. Click “Apply Selected.” 
9. The 949 template will display toward the bottom of the record. Edit the template to 

the applicable call number and item information for that item. Remember to type 
the information in uppercase. 

10. Go to the Action menu. 
11. Select “Save Record to Local File.” The record will stay in your file until you delete it. 
12. Click the black X in the upper right corner to shut the record. 

 
 

Remove Constant Data from a Record 
Remove constant data from a record if you applied the wrong template or applied the 
template twice.  
 

1. With the matching record for your item in need of cataloging open on your screen, 
click on the 949 template in need of removal. 

2. Select “Delete Field” from the menu. 
3. Go to the Action menu. 
4. Select “Save Record to Local File.” The record will stay in your file until you delete it. 
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5. Click the black X in the upper right corner to shut the record. 
 
 

Configure Export Settings  
Configuring export settings is only necessary before your first export in OCLC Connexion 
Client. No need to configure settings before each subsequent export.  
 
However, if you use OCLC Connexion Client on multiple computers, configure export 
settings in each Client. These settings are saved in each Client and not automatically 
transferrable to another Client.  
 

1. Go to the Tools menu. 
2. Select “Options.” 
3. From the Options pop-up, click on the “Batch” tab. 
4. Under “Perform local actions in batch,” ensure the box next to “Bibliographic 

Record Export” is unchecked.  
5. Click “Apply.”  
6. From the Options pop-up, click on the “Export” tab. 
7. Under “Destination,” click on “File: (Prompt for filename).” It will display highlighted 

in blue.  
8. Click on “Field Export Options.” 
9. On the pop-up box under “Bibliographic Records,” type:  

 
012, 029, 938 
 
Separate the numbers with a comma and a single space.  
 
This setting automatically removes the MARC tags 012, 029, and 938 from a record 
when exported from the Client.  

• The 012 contains information only used by the Library of Congress and the 
CONSER cooperative serials program.  

• The 029 contains an OCLC control number assigned to records created by 
non-OCLC systems, such as the British Library.  

• The 938 contains vendor order details, such as from Ingram. 
 

The 012, 029, and 938 serve no purpose for RSA and clutter the WorkFlows record 
display.  
 

10. Click OK to close the Field Export Options pop-up. 
11. Click “Apply,” then “Close” at the bottom of the Options box. 
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Export Records from Client 
1. Highlight your list of records in the save file. 

2. Click the Export toolbar button:   
3. From the “Look in:” drop-down menu, select the location to save the export file.  

 
RSA recommends saving the file to your desktop, making it easy to find to import 
into WorkFlows.  
 
The file will stay on your desktop until you delete it.  
 

4. Use the “File name” field to enter a name for the export file.  
 
Start with the first two letters of your library’s WorkFlows code in uppercase, the 
word “EXPORT” (without quotes), and the current date as MMDDYY.  
 
Example:   GAEXPORT082724 
 
For your file name, GA will be replaced with the first two letters of your library’s 
WorkFlows code.  
 

5. Click “Open.”  
 
The file export file displays on your desktop, typically as a white document with the 
file name below it.  
 
No need to double click the file to open it. Only WorkFlows can open it. 
 

6. Keep the exported records in the save file until you run the WorkFlows Load 
Bibliographic Records Report, explained in the next section of this document. 
Keeping the records in the Client save file allows you to return to them if they do not 
load into WorkFlows, you need to correct them, and then re-load them into 
WorkFlows.  

 
7. If you plan to export more records that same day, completely close Client by 

clicking the X in the upper right corner. Then reopen Client when you are ready to do 
your next export.  
 
If you do not completely close and reopen Client for your next export, it will 
automatically export those records into the first file you created that day.  
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Important Considerations for OCLC Holdings  
Although you exported the records from the Client, your library’s holding in OCLC 
WorldCat is not yet visible. The holding will be updated during RSA’s next run of the 
monthly process called OCLC Holdings Manager (OHM). OHM updates (both adds and 
removes) holdings for your library in OCLC based on what you have cataloged, deleted, or 
discarded from WorkFlows since the previous OHM run. 
 
You may update your library’s OCLC holding manually at the time of cataloging in 
Connexion Client if you prefer the item to be immediately available for OCLC WorldShare 
interlibrary loan requests sooner than the next run of OHM.  
 
If your library manually updates a holding, and you later delete that item from WorkFlows, 
you must manually remove your library’s holding from OCLC. OHM does not remove any 
holdings that were manually updated in Connexion Client or the web-based OCLC Record 
Manager.  
 
You are not required to update holdings manually. RSA recommends relying on OHM 
because it automatically – and effortlessly – keeps your library’s holdings updated in 
OCLC. OHM avoids the need for you to remember the additional step of manually removing 
the OCLC holding when the item is deleted from WorkFlows.  
 
Also, helpful to know: 
Serial records are excluded from OHM processing to avoid accidental removal or 
unwanted modification of OCLC local holding records (LHRs), such as "Retains current 
year only,” that may be associated with that serial. Some libraries create LHRs to indicate 
a specific serial’s availability for OCLC WorldShare interlibrary loan requests.  
 
Please check with your supervisor, Director, and/or interlibrary loan staff if you are unsure 
if your library manually updates OCLC holdings or enters LHRs. If you have questions or 
need assistance, please contact OCLC Support at support@oclc.org or  
1-800-848-5800. 
 
 

Import the OCLC Export File into WorkFlows 
1. Log into WorkFlows using your individual cataloging account. 
 
2. Click on the Utility module at the top of the WorkFlows screen.  

 
3. From the Common Tasks toolbar on the left, click on the MARC Import wizard.  

 
If a screen opens to review MARC import properties: 

a. Select the button next to “Never” at the top of this screen.  
b. Click OK at the bottom.  

mailto:support@oclc.org
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c. Left click on MARC Import to re-open the wizard. 
 

4. Click on the diamond-shaped gadget button next to the Source field.  
   
5. Use the drop-down menu next to “Look in:” to navigate to where your OCLC export 

file is saved (e.g., desktop, flash drive, etc.). 
 

6. Once you find the export file, single click on it.  
 

7. Then click the OK button. The location of your export file now appears in the Source 
field. 

 
8. In the field next to Destination, type the first two letters of your library’s WorkFlows 

code in uppercase, the word “EXPORT” (without quotes), and the current date as 
MMDDYY.  
 
Example:   GAEXPORT082724 
 
Enter the first two letters of your library’s WorkFlows code to allow easy recognition 
of your file when you run the report to load the records.  
 
For your file name, GA will be replaced with the first two letters of your library’s 
WorkFlows code.  
 
Do not include hyphens, periods, slashes, or any other special characters in the 
destination. WorkFlows will reject special characters and refuse to import the file.  
 

9. Click the Import button at the bottom of the screen.  
 

10. When a pop-up box asks, “Are there more files to upload?” select “No,” even if you 
do have another file of records to import into WorkFlows.  
 
By selecting “No,” you will import each file separately and run separate Load 
Bibliographic Records reports. Separate files with separate reports eases 
troubleshooting if any records load with errors.  

 
11. When the import log opens, typically as either an Excel or Notepad document: 

• Remember the number next to “number of record(s) processed.”  
• Make sure zero is next to “marc record(s) in error.” 

 
12. Close the import log by clicking the X in the upper right corner.  

 
13. Click “Cancel” at the bottom to close the MARC Import screen. 
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Your file of records is on the RSA server, but they are not yet searchable in WorkFlows or 
RSAcat until you run the Load Bibliographic Records Report, explained in the next section 
of this document. 
 
 

Run the WorkFlows Load Bibliographic Records Report 
1. Click on the Reports module at the top of the WorkFlows screen.  

 
2. From the Common Tasks toolbar on the left, click on the Schedule New Reports 

wizard.  
 

If a screen opens to review report settings: 
a. Uncheck the box next to “Review Settings Each Session” at the top of this 

screen. 
b. Click OK at the bottom.  
c. The Schedule New Reports wizard should automatically open.  

 
3. A tab labeled “Templates” opens. Click on the template named Load Bibliographic 

Records, which will start with the first two letters of your WorkFlows library code. 
This report is also referred to as the bibload report.  
 
Example: GA Load Bibliographic Records 
 
For your file name, GA will be replaced with the first two letters of your library’s 
WorkFlows code.  
 
If there is no Load Bibliographic Records report, email the RSA Help Desk at 
help@librariesofrsa.org.  
 

4. Click the “Set Up & Schedule” button at the bottom of the screen.  
 

5. Go to the second tab in the upper left corner, labeled “Load.” 
 

6. At the top of the report, go to the “File to load” drop-down menu. Select the file that 
begins with the first two letters of your library’s WorkFlows code, followed by 
EXPORT and the date as MMDDYY.  
 

7. Leave as-is all the report settings below the “File to load” drop-down menu because 
they are already correct.  

 
8. Click the “Run Now” button at the bottom of the screen. 

 
9. On the pop-up box that appears, click “Display Finished Reports.”  

mailto:help@librariesofrsa.org
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10. Wait for your Load Bibliographic Records report to show up at the top of the list. It 
may take a few minutes if other RSA libraries are running reports.  
 
Click the rabbit-in-the-hat helper button in the upper left corner to refresh the list of 
reports.  
 
 
Click the magnifying glass helper button, also in the upper left corner, to see if any 
other reports are running for RSA libraries, which may delay your report from 
running.  
 
 

11. When the Load Bibliographic Records Report shows up, click on it, and select 
“View.” If you see the error “The specified path was not found,” refer to the 
appendix of this document for a workaround.  
 

12. A report opens with the bibload results. Carefully check for any records that loaded 
into WorkFlows with errors. Errors will be indicated by asterisks (*) on the left 
margin of the report, followed by a description of the error.  
 
Try searching for the records with errors in the Call Number and Item Maintenance 
wizard.  
 
If you can find the record in WorkFlows, make the necessary edits (e.g., select the 
correct item type or fix a typo in the call number). Save your edits. 
 
If you are unable to find the record in WorkFlows, it likely failed to load. Return to 
the OCLC Connexion Client save file, correct the 949 tag, export the record, import 
it into WorkFlows, and run the Load Bibliographic Records report again.  
 
If the record continues to cause a bibload error, or you need other bibload 
assistance, contact the RSA Help Desk at help@librariesofrsa.org or 1-866-940-
4083. Please do not remove the bibload report from WorkFlows because RSA will 
use it to troubleshoot the error.  
 

13. Further down on the Load Bibliographic Records Report log, look for the line that 
reads “catalog record(s) printed.” Make sure the number in this line matches the 
“number of records processed” that you noted from the import log.  
 

14. Close the Load Bibliographic Records Report by clicking the X in the upper right 
corner.  
 
No need to remove the report because RSA automatically removes them once they 
reach about one month old.  

mailto:help@librariesofrsa.org
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No need to save a copy of the report on your computer, flash drive, etc., unless for 
internal purposes. Check with your supervisor or Director if you are unsure if you 
should save Load Bibliographic Records Reports.  
 
Please be careful not to accidentally remove the Load Bibliographic Records Report 
template. You will be unable to load records into WorkFlows until RSA re-creates it. 
Contact the RSA Help Desk at help@librariesofrsa.org or 1-866-940-4083 if you 
remove the report template. 
 

15. Click the Close button at the bottom of the Finished Reports screen.  
 
The OCLC records, along with your library’s items attached to them, are now 
searchable in WorkFlows. However, they will not be searchable in the RSAcat until 
indexing finishes, which may take up to 2 hours.  
 

16.  Go to the location where you saved your OCLC export file (e.g., desktop, flash 
drive). Right click on the file and select “Delete.” 
 
 

Delete Records from the Client Save File 
To delete a single record: 

1. Go to your OCLC Connexion Client save file. 

2. The record will open. Click the Delete Records toolbar button:  
3. Click Yes on the pop-up that asks you to confirm the deletion.  

 
To delete multiple records: 

1. Go to your OCLC Connexion Client save file. 
2. The list of records will display. Click on the first record in need of deletion and drag 

your cursor down to highlight the rest of the records in need of deletion. 

3. Click the Delete Records toolbar button:  
4. Click Yes on the pop-up that asks you to confirm the deletion. 

 
 
  

mailto:help@librariesofrsa.org
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Appendix A: Brief Record Cleanup Using OCLC Connexion Client  
 
Libraries are encouraged but not required to use OCLC Connexion Client to replace brief 
records with OCLC records. 
 
Please submit a report request for RSA to run a brief record report and email it to you.  
 
You may also run a brief record report if you or another staff member at your library has 
BLUEcloud Analytics access.  

When entering your library's information into the 949 tag on the OCLC record that will 
replace the brief record, enter the same call number, item ID, home location, price, item 
type, and item categories 1-5 that are already assigned to your library’s item attached to 
the brief record. 

The existing call number/item information attached to the brief record is not updated if the 
incoming OCLC record’s 949 tag has the same item ID but different information elsewhere 
in the 949 (e.g., price, item categories 4 or 5). The existing call number/item information 
stays as-is when the replace happens.  
 
If you want to edit any of the call number/item information already attached to the brief 
record, please do that in the WorkFlows Call Number and Item Maintenance wizard. 
Importing an OCLC record with a revised 949 tag will not update the existing call 
number/item information already in WorkFlows.  

When you import the OCLC record into WorkFlows, the brief record should be replaced 
with the incoming OCLC record. The record will display an “item ID already exists” error on 
the Load Bibliographic Records report log, which is normal. The brief record can still be 
replaced by the OCLC record despite that error. You should look up the item in WorkFlows 
to ensure its brief record has been successfully replaced with the OCLC record.  

At the time of the replace, a second copy for your library will not be created because you 
entered the call number/item information for the existing copy into the OCLC record’s 949 
tag.  

If the brief record fails to be replaced by the OCLC record, please reach out to the RSA 
Help Desk and leave the finished Load Bibliographic Records report in WorkFlows. RSA will 
use it to investigate the failed replace and follow up with you.  
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Appendix B: Updating the Path for Viewing/Printing Bibload Reports   
 
WorkFlows uses the WordPad program to view Load Bibliographic Record (bibload) 
reports. A Windows 11 update unfortunately removes WordPad from Windows 11 
computers. Follow the procedure below if you see a “specified path was not found” error 
when trying to view a bibload report.  
  

1. On your computer, find the file path for your library’s preferred word processing 
program. If you are unsure how to find it, RSA recommends asking your IT staff for 
help.  
 

2. Use Ctrl c to copy the file path for the word processing program on your computer. 
RSA is unable to tell you the exact path because each computer network is 
different, but here are a couple of suggestions:  

 
If you have Microsoft Word, this path may work:  
C:\Program Files\Microsoft Office\root\Office16\WINWORD.EXE  
  
If there is no Microsoft Word on your computer, use Notepad, which is installed on all 
Microsoft computers. Its path is:  
C:\Windows\notepad.exe  
 

3. Log into WorkFlows using the CIRC or an individual cataloger account. 
 

4. Go to the Reports module at the top of the screen. 
 

5. In Common Tasks on the left side of the screen, click the Report Session wizard. 
 

 
 

6. In Report Session, click in the field to the right of “Application to view reports” to 
highlight the current file path in blue. Use Ctrl v to paste in the file path for your 
library’s preferred word processing program.  
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7. Click in the field to the right of “Application to print reports” to highlight the current 
file path in blue. Use Ctrl v again to paste in the file path for your library’s preferred 
word processing program.  

 
Here is an example of what the new settings may look like: 
 

 
 

8. Click “OK” at the bottom of the Report Session screen to save the settings. 
   

9. When you click the X in the upper right corner to completely shut WorkFlows, click 
“yes” when asked if you want to save the changed properties.  

 
10. Repeat these steps on each WorkFlows used to view bibload reports if you see the 

“specified path was not found” error. 
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Appendix C: Removing a Stuck Record from the Client Save File 
 
A record may become stuck in your OCLC Connexion Client local save file. You are unable 
to remove it using the Delete Records toolbar button. To resolve the stuck record so you 
can delete it from the save file, follow the steps below. 
 

1. Click on the File menu in the upper left corner. 
 

 
 

2. Click on Local File Manager. 
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3. Click on the DefaultBib.bib file path so it appears highlighted in blue. 
 

 
 

4. Click on the Compact/Repair button.  
 

5. You will see a pop-up box with the warning below. Click OK.  
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6. Once compact/repair is finished, you will see another pop-up box with the message 
below. Click OK. 

 

 
 

7. Open your local save file, select the record to delete, and click the Delete Records 
toolbar button. You should be able to delete the record now. 
 

If you are still unable to delete the record after following these steps, please contact OCLC 
Support at support@oclc.org or 1-800-848-5800.  
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